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Chapter 1

Getting Started

Getting started with the Estate Planning QuickView is easy. Before you install the
program, be sure that you’re running a Windows 95 or later operating system. The Estate
Planning QuickView does not run on Windows 3.1 or earlier operating systems.
Installing the Program
1. Insert the disk into the disk drive.
2. On the Windows Taskbar, click the Start button.
3. On the Start menu, click Run. The Run dialog box appears. In the Open box,
A:\setup.EXE should appear. If it doesn’t, type A:\setup.EXE.
4. Click OK.
5. The setup program begins. Follow the instructions in the setup program.
Uninstalling the Program
1. On the Windows Taskbar, click the Start button.
2. Point to Settings and click Control Panel. The Control Panel window appears.
3. Click Add/Remove Programs. The Add/Remove Program Properties dialog box
appears.
4. Use the scrollbar to find the Minimum Distributions Calculator. When you find it,
click the program title. Notice that the Add/Remove button is now functional.
5. Click the Add/Remove button.
6. The uninstall program begins. Follow the instruction in the uninstall program.
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Introducing Estate Planning QuickView
Welcome to Estate Planning QuickView
Estate Planning QuickView illustrates the relative tax advantages of several different
estate planning scenarios. The program displays up to eight different estate plans for
married clients and two different estate plans for single (unmarried) clients. In all plans in
which a married couple has jointly owned assets, such assets pass to the estate of the
surviving spouse (except in community property states, in which the “joint” assets are
divided between the estates of the husband and wife as community property).
In order for you to view results quickly and easily, the program includes a number of
assumptions about estate distributions and valuations. This means, that in some cases, the
program’s calculations may not be entirely accurate. For example, although the program
calculates death taxes, such calculations serve as comparisons and illustrations, not
determinations of actual liabilities.

What do I See on the Screen?
When you run the program, the Estate Planning QuickView window appears. Following
is a description of what you see when you run the program.
Title Bar
The title bar appears at the top of the window. It contains the following information:

•

Program title

•

Program version number

•

File name (if the file has been saved)
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Menu Bar
The Menu bar is below the title bar. The Menu bar contains three menus you use to click
program commands. Use the menus on the Menu bar to control your files and the
program or to get Help.

Toolbar
The toolbar is below the Menu bar. The toolbar contains graphics as commands. You
can click these graphics instead of using the related menu bar commands.

Open Files

Save Files

Access the Web

Print Files

Get Help

Client Data Section
The Client Data section allows you to enter the data needed to begin an analysis. If you
are required to enter additional data, the program will prompt you to do so. For
instructions on entering data, click here.
Summary Results and Help Instructions
While viewing the Client Data section, you can also view a summary of the results or
view instructions for entering data.
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Function Keys
Use the Function Keys for frequently used commands. The Function Keys are located at
the top of your keyboard.

Keys

Descriptions

F1

Access the Help system.

F2

Save a file.

F3

Open a file.

Also, you can use the following key combinations for frequently used commands:

Keys

Descriptions

Alt + S

Save an existing file (Save As).

Alt + P

Print a file.

Alt + R

Format a report.

Alt + S

Exit the program.

Alt + D

View client data.

Alt + W

View the flowcharts.

Alt + G

View the graphs.

Alt + E

Enter expenses.

Alt + C

Access the Help contents.

Alt + U

Find out how to use Help.

Alt + H

Search the Help index.
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Working with Files
Frequently Used Procedures
Following are procedures for creating, opening, and saving files within Estate Planning
QuickView.
Creating a New File
•

On the File menu, click New. The program clears all previous data entry and
resets the program's default values.

Opening an Existing File
1. On the File menu click Open. Or on the toolbar, click
appears.

. The Open dialog box

2. In the File name box, enter the name of the file and proper extension of the file
that you want to open. Be sure you have selected the proper drive and folder of
your file.
Opening QuickView ’99 or earlier files
1. On the File menu click Open. Or on the toolbar, click
appears.
2. In the Files of type box, click

. The Open dialog box

.

3. From the list, click Previous QuickView Versions.
4. Open the file named cases.db.
5. In the box that appears, select the case that you want to open.
Saving a File
1. On the File menu, click Save. Or on the toolbar, click

.

2. If the file has not been saved previously, the Save As dialog box appears.
3. In the File name box, type a name for the file. The program automatically adds
the proper extension to the file name.
4. Select the drive and folder in which to save the file.
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Saving an Existing File
1. Open an existing file or create a new file.
2. On the File menu, click Save As. Or on the toolbar, click
box appears.

. The Save As dialog

3. In the File name box, enter a name for the new file. The program automatically
adds the proper extension to the file name.
4. Select the drive and folder in which you want to save the file.
Exiting the Program
1. Be sure that you save your file before exiting the program.
2. On the File menu, click Exit.
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Entering Data

Client Data Section
Entering data into Estate Planning QuickView is easy. Nearly all data entry takes place in
one section. You will begin entering data for each file in the Client Data section.

Input

Description

Status

All files are based upon cases that involve either a Single
individual or a Married couple. On the left side of the
window, you will see two buttons. Click Single or Married.

Preferences

The Preferences box lets you enter different names for
Marital Trusts, Nonmarital Trusts, Heirs, and the

The names that you enter in the Preferences box will appear
in the Flowcharts. For more information, see Preferences
later in this chapter.
Names

Enter the first names of the couple in the Husband and Wife
boxes. Enter their last name in the Joint box. If a husband
and wife have different last names enter their full names in
their respective boxes and do not enter anything in the Joint
box.
The names that you enter here will appear throughout the
program and on the printed reports.
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Net Assets

You can simplify your data entry by entering all values net of
debts and estimated administration expenses. When entering
Net Assets, enter the values of all assets other than
retirement benefits and life insurance in the Joint column.
This includes probate assets and revocable trust assets.
When the domicile is one of the community property states
(Arizona, California, Idaho, Louisiana, Nevada, New
Mexico, Texas, Washington, or Wisconsin), the program
divides these assets equally between the husband's separate
estate and the wife's separate estate upon the death of the
first-to-die.
In non-community property states, all joint assets pass to the
survivor, except in plans that make use of the unified credit.
In such cases, the remainder of the joint assets (after credits
have been titled) pass to the estate of the survivor.
To enter Gross Assets, see Gross Assets Box later in this
chapter.

Life Insurance

Enter the total death benefits payable on all life insurance
that is included in the gross estates of the husband and wife.
This includes all life insurance in which they have any
incident of ownership such as the power to name the
beneficiary of the policy or borrow against the policy. In the
Joint column, enter the amount of total death benefits
payable under any second-to-die life insurance payable upon
the death of the survivor of the husband and wife if either of
them have any incident of ownership in the policy.
Note
In the case of death, the Current Year determines whether or not the
program applies the “three-year rule.” The “three-year rule” implies that
if the plan owner dies within three year of the Current Year, life
insurance is not removed from the estate.
In Plans 5, 6, 13, and 14, the program will automatically transfer all life
insurance, including both life insurance owned by the spouse and joint
or second-to-die insurance, into an irrevocable life insurance trust that
is no longer part of the taxable estates of the husband or the wife.
However, if death occurs within three years of the transfer, the program
pulls life insurance back into the taxable estate.
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Retirement Plans

Enter the values of any qualified retirement plans or
individual retirement accounts that will be payable to
beneficiaries upon the death of the husband or wife. In the
Husband column, enter the total value of the plans that the
husband is the owner or participant. In the Wife column,
enter the total value of the plans for which the wife is the
owner or participant.
Although retirement plan are taxable income for federal (and
many state) income tax purposes, the program does not
project any federal or state income taxes on retirement plan
distributions. The program only uses retirement plan assets to
calculate certain state death taxes.

Adjustable Taxable Gifts

Enter the total cumulative amount of post-1976 taxable gifts
for both the husband and wife (that is, gifts in excess of the
annual exclusion that do not qualify for any marital,
charitable, or other deduction).

Estate Growth

Enter the rate at which you expect the non-insurance assets to
grow. The program does not apply growth rates to insurance
policies. However, it does apply growth to insurance
proceeds after the death of the insured. If you’ re entering a
rate of 5%, enter 5, not 0.05. The % sign is optional. The
program compounds the growth rate annually and applies it
to the estates in accordance with the years of death that you
have entered.

Year of First Death

Enter the assumed years of death for the First-to-Die and the
Survivor. This is relevant for unified credit and other
scheduled tax changes as well as the optional estate growth
calculations. This does not necessarily mean that the husband
dies first.

Year of Second Death
Domicile

Enter the abbreviation for the owner’s state of domicile. Or
click the down arrow and select the abbreviation from the
drop-down list. The program will use this abbreviation to
calculate state death tax.
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Nontaxable Assets Section

Input

Description

Include Nontaxable Assets Check Box

If there are life insurance policies, lifetime gifts, or
other assets that have already been removed from
the estates of the husband and wife, but you still
wish to show such values in the flowcharts and
other reports, be sure that you select the Include
Nontaxable Assets check box. The program
selects this check box by default.

Total Nontaxable Assets

Enter the value of the assets (other than insurance
polices) that are not part of the taxable estate of
either the husband or the wife that will appear as
part of the estate plans.

Name (or Title):

This is the title that you’ve specified in the
Preferences box.

Insurance: on Husband

Enter the total nontaxable death benefit from
insurance policies on the husband. For example,
policies owned by an irrevocable trust.

Insurance: on Wife

Enter the total nontaxable death benefit from
insurance policies on the wife. For example,
policies owned by an irrevocable trust.

Insurance: on 2nd-To-Die

Enter the value of nontaxable survivorship life
policies (for estate tax purposes).
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Preferences Box
The Preferences box lets you enter different names for Marital Trusts, Nonmarital
Trusts, Heirs, and the Nontaxable Trust. The names that you enter in the Preferences
box will appear in the Flowcharts.

Also, the Preferences box contains the Current Year box. The Current Year determines
growth factors, and in the case of death, whether or not the “three year rule” applies. The
“three year rule” implies that if the plan owner dies within three years of the Current
Year, life insurance is not removed from the estate.
State 'Credit Tax’ allows you to select how state death taxes that are based on the state
death tax credit (sometimes called “slack taxes” or “sponge taxes”) will be calculated in
future years. Most states will follow section 2011 of the Internal Revenue Code as
amended by the Economic Growth and Tax Relief Reconciliation Act of 2001, which
phases-out the credit from 2002 through 2004 and eliminates the credit after 2004. So for
most states, "Phase-out" will be the correct preference. However, it appears that 13 states
(Arizona, Georgia, Iowa, Kansas, Maine, Minnesota, New York, North Carolina, Rhode
Island, South Carolina, South Dakota, Virginia, and Washington) will not follow the
amendment to section 2011 and will continue to impose a death tax equal to the full
amount of the credit. After 2004, when there is not supposed to be a credit but a
deduction for state death taxes, it is possible that some of those states will deduct the tax
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from the taxable estate for the purpose of calculating the credit under section 2011 while
other states will follow present law and not deduct its own death tax for the purpose of
calculating the tax. The "No Phase-out; No Deduct" preference is for those states that
will not deduct their own death tax for the purpose of calculating the death tax and the
“No Phase-out; With Deduct” preference is for those states that will allow a deduction for
the tax in calculating the tax.
Default Domicile allows you to set the state input to a specific state every time the
program starts.
Estate Tax allows you to select how future estate tax calculations under the Economic
Growth and Tax Relief Reconciliation Act of 2001 will be handled: 2011 Sunset (to show
the law as now written, with repeal in 2010 and reinstatement of prior law in 2011), 2010
Repeal in 2010+ (to assume that estate tax repeal is permanent), or 2009 Rates in 2009+
(to show no repeal and the continuance of 2009 rates and credits).

Note
Plans 5, 6, 13, and 14 demonstrate the “three year rule.” In these plans, the program will automatically
transfer all life insurance, including both life insurance owned by the spouse and joint or second-to-die
insurance, into an irrevocable life insurance trust that is no longer part of the taxable estates of the husband
or the wife. However, if death occurs within three years of the current year, life insurance is pulled back into
the taxable estate.

Gross Assets Box
You can enter Gross Assets instead of Net Assets. To enter Gross Assets, click the blue
cross, located to the right of Net Assets. The Asset Adjustments window appears.
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Input

Description

Adjust entered asset values for
administration or other
expenses?

When entering gross values, you can enter probate
percentages and dollar amounts of debts or fixed expenses
that will reduce the gross value that you enter. When
entering gross assets, the program makes the division of
the community property before calculating the
administrative or other expenses that are a percentage of
the estate. No change is made to the treatment of life
insurance or retirement benefits.
When the domicile is one of the community property
states (Arizona, California, Idaho, Louisiana, Nevada,
New Mexico, Texas, Washington, or Wisconsin), the
program divides these assets equally between the
husband's separate estate and the wife's separate estate
upon the death of the first-to-die.
In non-community property states, all joint assets pass to
the survivor, except in plans that make use of the unified
credit. In such cases, the remainder of the joint assets
(after credits have been titled) pass to the estate of the
survivor.

Probate Percentage

This value signifies the percentage of the estate used for
administrative or other expenses such as fiduciary
commissions or attorney’s fees. The program will reduce
the value of the probate estate by the percentage that you
enter here.

Debts or Fixed Expenses

Enter any debts or fixed expenses that the program should
deduct from the estate.

State Inputs Window
If you select a state that imposes a state death tax independent of the federal estate tax,
and if that state requires additional information to calculate that tax, a button appears to
the right of the Domicile box. Click the button to enter the state specific tax information.
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Depending on the state, enter the following information. The program only allows you to
enter information specific to the state that you select.

Input

Description

Percent of Nonmarital Trust that is
Taxable at First Death

In some states, a life estate or other interests of the
surviving spouse in a trust may be exempt from tax, so
only the value of the children's interests are taxable.
Enter the percentage of the unified credit or nonmarital
trust that should be considered taxable upon the death
of the first-to-die.

Percent of Retirement Benefits that
are Taxable

In some states, only retirement benefits attributable to
employee contributions are subject to tax, while the
benefits attributable to employer contributions are
exempt from tax. Enter the percentage of any
retirement plan or benefits that should be considered to
be taxable.

Number of Children

In some states, the number of beneficiaries affects the
calculation of the inheritance tax. The program
assumes that the children of the client(s) are the
beneficiaries.
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Viewing the Estate Plans
Plan Descriptions
Estate Planning QuickView generates eight different estate plans for married clients and
two different estate plans for single (unmarried) clients. In all married plans, the jointly
owned assets pass to the surviving spouse and become part of the estate of the surviving
spouse, except in community property states for which the program divides the “joint”
assets between the estates of husband and wife as community property.
You can view the results in the forms of flowcharts, graphs, or summary reports. Plans 1
through 8 display cases in which the husband dies first. Plans 9 through 16 display cases
in which the wife dies first.

Plan

Description

Plans 1 and 8

All to Surviving Spouse

Plans 2 and 9

Unified Credit By-Pass Trust with Outright Marital
Deduction
The decedent's assets, life insurance, and retirement benefits are
divided between a nonmarital (or unified credit or by-pass) trust
and the surviving spouse in accordance with a unified credit or
optimum marital deduction formula. Such a formula is intended
to reduce the federal estate tax to the lowest possible amount,
taking into account both the unified credit and the state death tax
credit (if a state death tax is otherwise payable).
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Plans 3 and 10

Unified Credit By-Pass Trust
These plans are similar to Plans 2 and 10, but with the addition
of a marital trust. The decedent's assets, life insurance, and
retirement benefits are divided between a nonmarital (or unified
credit or by-pass) trust and a marital trust (qualifying for the
marital deduction) in accordance with a unified credit or
optimum marital deduction formula. Such a formula is intended
to reduce the federal estate tax to the lowest possible amount,
taking into account both the unified credit and the state death tax
credit (if a state death tax is otherwise payable).

Plans 4 and 11

Marital Transfers to use Both Unified Credits; Unified
Credit By-Pass Trust with Marital Trust
These plans are similar to plans 3 and 11, but the program will
automatically shift assets in the following ways:
•

From the spouse with the larger estate to the spouse with
the smaller estate

•

From jointly owned assets to the spouse with the smaller
estate.

The program only shifts enough assets necessary to give both
spouses the ability to fund a unified credit or by-pass trust
regardless of who should die first.
As in Plans 3 and 11, the decedent's assets, life insurance, and
retirement benefits are divided between a nonmarital (unified
credit or by-pass) trust and a marital trust (qualifying for the
marital deduction) in accordance with a unified credit or
optimum marital deduction formula. Such a formula is intended
to reduce the federal estate tax to the lowest possible amount,
taking into account both the unified credit and the state death tax
credit (if a state death tax is otherwise payable).
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Plans 5 and 12

Transfers of all Life Insurance to Irrevocable Trusts
These plans are similar to plans 3 and 11. But the program will
automatically transfer all life insurance, including both life
insurance owned by the spouse and joint or second-to-die
insurance, into an irrevocable life insurance trust that is no
longer part of the taxable estates of the husband or the wife.
However, if death occurs within three years of the transfer,
life insurance is pulled back into the taxable estate.
The program displays the life insurance as nontaxable assets
passing to the children. As in plans 3 and 11, the assets and
retirement benefits of the first-to-die are divided between a
nonmarital (unified credit or by-pass) trust and a marital trust
(qualifying for the marital deduction) in accordance with a
unified credit or optimum marital deduction formula. Such a
formula reduces the federal estate tax to the lowest possible
amount, taking into account both the unified credit and the state
death tax credit (if a state death tax is otherwise payable).

Plans 6 and 13

Marital Transfers to Use both Unified Credits; Transfers of
all Life Insurance to Irrevocable Trusts
These plans are similar to plans 5 and 13. But the program will
automatically shift assets in the following ways:
•

From the spouse with the larger estate to the spouse with
the smaller estate

•

From jointly owned assets to the spouse with the smaller
estate

The program only shifts enough assets necessary to give both
spouses the ability to fund a unified credit (or by-pass) trust
regardless of which should die first.
As in plans 5 and 13, all life insurance is transferred into an
irrevocable life insurance trust that is no longer part of the
taxable estates of the husband or the wife if the year of death is
more than three years from the current year. However, if death
occurs within three years of the transfer, life insurance is
pulled back into the taxable estate.
The assets and retirement benefits of the first-to-die are divided
between a nonmarital (or unified credit or by-pass) trust and a
marital trust (qualifying for the marital deduction) in accordance
with a unified credit or optimum marital deduction formula.
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Plans 7 and 14

None to Surviving Spouse
None of the decedent's assets, life insurance, and retirement
benefits are distributed to or for the surviving spouse, but are
instead distributed as part of the nonmarital trust (not qualifying
for the marital deduction), ultimately passing to the children
outside of the surviving spouse's estate.

Flowcharts
The flowcharts display the results of one plan at a time. From the flowcharts you can see
how money passes from the owner, through trusts, and to the heirs. The flowcharts
display total taxes and the net assets that pass to the heir.
Viewing the Flowcharts
1. On the toolbar, click Flowcharts. Plan 1 appears.
2. To view plans in ascending order, click Next Plan. To view plans in decreasing
order, click Previous Plan.
Reading the Flowcharts
•

The first row of flowchart boxes display assets upon the death of the first-to-die.

•

The second row of flowchart boxes displays the taxes due upon the death of the
first-to-die.

•

The third row of flowchart boxes represents the values upon the death of the
second-to-die.

•

The fourth row of flowchart boxes displays the taxes due upon the death of the
second-to-die.

•

The last row of flowchart boxes displays the total taxes for both estates and the
total value that passes to the heirs.
Note
You can display the lines in the flowcharts in black or in red and green. If you click Color Flowchart Lines on
the View menu, the lines will appear red and green. Red lines extending from a box indicate that money
being transferred is taxed. Green lines extending from a box indicate that money being transferred is not
taxed.
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Graphs
The graphs display a comparison of the net assets that pass to the heir for all plans or a
comparison of the total estate taxes.
Viewing the Graphs
1. On the toolbar, click Graphs.
2. Click the tabs at the top of the graph to view comparisons of plans 1-8 or plans 916. The active tab is white.

Summary Reports
The summary reports list the total estate taxes and the net assets that pass to the heirs.
Viewing the Summary Reports
•

The Summary Report appears below the client data section of the program. Use
the scroll bar to the right of the report to view more results. Click the Expand
button to view the Summary Report full-screen.
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Formatting Reports for Printing

Estate Planning QuickView allows you to format your reports with headings,
personalized fonts, and page margins. You can also select to print the date and time on
your reports. To format your reports, you will use the Report Options window.
Accessing the Report Options Window
• On the File menu, click Report Options.
Creating a Heading for a Report
1. In the Report Options window, click the Heading box.
2. Type the text that you want to display at the top of your printed report.
Formatting Page Margins
You will format page margins using the Page Margins group box in the Report Options
window. The Page Margins group box contains boxes for you to enter top, bottom, left,
and right page margins.
•

In the Page Margins group box, enter the Top, Left, Bottom, and Right margin
settings (in inches).

Formatting the Text of a Report
You will format the text of your reports using the Fonts group box in the Report Options
window. The Fonts group box contains three types of text to format: Title, Body Text,
and Headers. The name of the font and its size appear next to each type. The text appears
in the same color as it will on the printed report.

1. In the Fonts group box, click the text (Title, Body Text, or Headers) that you
want to format. The Font dialog box appears.
2. Format the Font, Style, Size, and Effects of the text and click OK.
3. Notice the description of the text in the Report Options window has changed.
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Printing the Date and Time
Use the Printing Options group box in the Report Options window if you want the date
and time printed on reports.
•

In the Printing Options group box, click the Print Date and/or Print Time
check boxes.

Printing Page Numbers
•

In the Printing Options group box, click the Print Page #’s check box.

Editing the Cover Page
1. On the toolbar, click Final Report.
2. Click the Edit Cover Page button located at the bottom of the window. The
Configure Report window appears.
3. Click Left, Center or Right to align your text on the page.
4. Enter the preparer’s name, the company name, and any additional information
that should appear on the Cover Page.
5. Click OK to create the Cover Page.
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Printing Reports and Graphs
Selecting Reports to Print
Estate Planning QuickView allows you to print the following items, enabling you to build
a Final Report. You can click as many of the following items as you like.
•

Cover Page—Prints the preparer’s Name, Company Name, and additional
information of your choice. You can also left align, right align, or center this
information.

•

Summaries—Prints brief descriptions of each plan, including the names of the
estate owners.

•

Client Data Inputs—Prints the information in the Client Data section.

•

Graphs—Prints the program’s graphs.

•

Detailed Plan Descriptions—Prints more in depth descriptions of the plans than
the Summaries.

To see what will actually be printed on each of these reports, click the Print Preview
button at the bottom of the window.
Selecting Flowcharts to Print
The Select Flowcharts: section contains options for selecting which flowcharts you will
print. In the middle of this section, you will see descriptions of each of the plans.
Choosing the First-to-Die

•

For each report description, click Husband Dies First, Wife Dies First, or a
combination of both.

•

If the first-to-die will be the same for every report, click Select All for Husband
Dies First or Select All for Wife Dies First.

•

If you want to show the most extensive set of results, you can select both Select
All for Husband Dies First and Select All for Wife Dies First.

•

If you do not want to print flowcharts, click Deselect All.
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Previewing Reports
After selecting and formatting reports, graphs, and flowcharts for printing, you can
preview your Final Report.
•

Click Print Preview. The Preview Reports window opens.

•

Click Zoom to increase magnification.

•

Click Full Page to decrease magnification.

•

Click the arrow buttons to move through the pages of report.

Setting up a Printer
1. On the File menu, click Print.
2. In the Print Options section, click Printer Setup.
Printing Reports to a Text or Spreadsheet File
When you save a report as a text or spreadsheet file, you are saving the inputs and the
plan descriptions. You cannot save the flowchart calculations.
1. On the toolbar, click Final Report.
2. Click the Print to File button located at the bottom of the window. The Exporting
Reports window appears.
3. Click Text File or Spreadsheet File.
4. Click Create File. The Save As dialog box appears.
5. Save the file.
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Reference Material
To keep procedures free from lengthy discussions, this manual refers to the following
material.

Community Property
When the domicile is one of the community property states (Arizona, California, Idaho,
Louisiana, Nevada, New Mexico, Texas, Washington, or Wisconsin), the program treats
the “joint” assets as community property. The program divides these assets equally
between the husband's separate estate and the wife's separate estate upon the death of the
first-to-die. If you have entered values as “gross” values instead of “net,” the program
makes the division of the community property before calculating the administrative or
other expenses that are a percentage of the estate. No change is made to the treatment of
life insurance or retirement benefits.
In non-community property states, all joint assets pass to the survivor, except in plans
that make use of the unified credit. In such cases, the remainder of the joint assets (after
credits have been titled) pass to the estate of the survivor.

Total Taxes
The Total Taxes shown in the flowcharts is the total of the taxes at the first death and the
second death. If you have entered a growth rate, and the deaths are projected to occur in
different years, the program applies the same growth rate to the taxes at the first death
when totaling the taxes. This way, the total reflects the true economic cost of the taxes
paid at the first death.

Federal Estate Tax Calculations
Death Taxes always reflect the sum of the federal estate tax and any state death tax that
may be imposed.
Under the Economic Growth and Tax Relief Reconciliation Act of 2001, the state death
tax credit will be reduced by 25% in 2002, by 50% in 2003, by 75% in 2004, and
eliminated in 2005, when estates will be allowed a deduction (not a credit) for state death
taxes paid. Of the states that impose death taxes that are supposed to be equal to the
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credit, thirteen seem to have defined the amount of the credit based on federal tax law as
it existed on a particular date before the enactment of EGTRRA. In those states
(Arizona, Georgia, Iowa, Kansas, Maine, Minnesota, New York, North Carolina, Rhode
Island, South Carolina, South Dakota, Virginia, and Washington), the state death tax may
exceed the credit beginning in 2002. Because these laws may change over the next year
or two, and to provide flexibility, the user must specify as a “Preference” whether or not
the state death tax will conform to the federal credit.
Every state imposes a death tax at least equal to the state death tax credit allowed in
determining the federal estate tax, and 10 states (in 2001) impose an independent
inheritance, succession, or estate tax on transfers to spouses or heirs/beneficiaries that
may exceed the state death tax credit.
The program calculates the federal estate tax based only upon the following values:
•

Assets

•

Marital deduction

•

Unified credit

•

Amounts of adjusted taxable gifts

•

State death tax credit

•

Credit for gift tax paid

For simplicity, the program assumes that if the total taxable gifts exceed the unified credit
applicable exclusion amount, a gift tax was paid on the gifts in excess of the applicable
exclusion amount, and credit is taken for the gift tax assumed to have been paid. The
actual gift tax could have been more or less than the assumed gift tax, depending on the
timing of the gifts.
Unified Credit Formulas
The program illustrates several estate plans that rely on a unified credit or optimum
marital deduction formula. This formula can be summarized as follows:
The largest amount (if any) that can pass free of federal estate tax or will result in the
least possible estate tax, taking into account the federal estate tax unified credit and the
state death tax credit.
When there is no state death tax independent of the state death tax credit, the
“nonmarital” or “unified credit” share of the estate will be the applicable exclusion
amount, less any adjusted taxable gifts.
If there is a state death tax that is independent of the state death tax credit, the calculation
may become circular. First, the nonmarital share is calculated as if there were no state
death tax. Second, the state death is calculated. Third, the nonmarital share is
recalculated, taking into account the credit generated by the state death tax. Fourth, the
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state death tax is recalculated. This cycle continues until the calculations converge on a
single number.
The program assumes that all assets included in the gross estate are available to fund the
nonmarital share, regardless of whether the assets are probate assets, life insurance, or
retirement benefits.
The program also assumes that all death taxes will be paid from the nonmarital share.
Usually, this is only state death tax unless the estate plan uses less than the optimum
marital deduction.
Marital Deduction
In all cases, the marital trust qualifies for the federal estate tax marital deduction, and
the program includes this in the gross estate of the surviving spouse. The nonmarital
trust does not qualify for the marital deduction and is not included in the gross estate of
the surviving spouse, regardless of whether or not the surviving spouse is a beneficiary of
the trust.
Except for the nonmarital share, the program assumes that all other assets of the estate
will pass to or in trust for the surviving spouse, and they qualify for the federal estate tax
marital deduction.
Federal Estate Tax Rates
The federal estate tax is calculated from a tax base equal to the sum of the taxable estate
and the adjusted taxable gifts.
Before 2002 and for taxable estates between $10,000,000 and $17,184,000, there is an
additional 5% imposed (or a total tax rate of 60%) until the benefits of the lower tax
brackets have been eliminated. The average tax rate is 55%. Before the Taxpayer Relief
Act of 1997, the 5% tax applied until the benefit of the unified credit was also eliminated.
This part of the 1997 Act was a technical error, but Congress chose not to correct the
error in the Technical Corrections Act of 1998.)
The unified credit and state death tax credit are deducted from the tentative tax to
determine the actual federal estate tax.

Estate Value

Tax

$0 to $10,000

18%

$10,000 to $20,000

$1,800 plus 20% over $10,000

$20,000 to $40,000

$3,800 plus 22% over $20,000
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$40,000 to $60,000

$8,200 plus 24% over $40,000

$60,000 to $80,000

$13,000 plus 26% over $60,000

$80,000 to $100,000

$18,200 plus 28% over $80,000

$100,000 to $150,000

$23,800 plus 30% over $100,000

$150,000 to $250,000

$38,800 plus 32% over $150,000

$250,000 to $500,000

$70,800 plus 34% over $250,000

$500,000 to $750,000

$155,800 plus 37% over $500,000

$750,000 to $1,000,000

$248,300 plus 39% over $750,000

$1,000,000 to $1,250,000

$345,800 plus 41% over $1,000,000

$1,250,000 to $1,500,000

$448,300 plus 43% over $1,250,000

$1,500,000 to $2,000,000

$555,800 plus 45% over $1,500,000

$2,000,000 to $2,500,000

$780,800 plus 49% over $2,000,000

$2,500,000 to $3,000,000

$1025,800 plus 53% over $2,500,000

Over $3,000,000

$1,290,800 plus 55% over $3,000,000

Under the Economic Growth and Tax Relief Reconciliation Act of 2001, the maximum
estate and gift tax rate will be reduced to 50% in 2002 (with no additional 5% tax), and
will decline by 1% each year after that until the maximum rate is 45% in 2007.
Unified Credit
Under the Economic Growth and Tax Relief Reconciliation Act of 2001, the estate tax
unified credit is scheduled to increase by steps each year until 2009, from $600,000 to
$3,500,000, as follows:
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Year

Exclusion

Credit

1997

$600,000

$192,800

1998

$625,000

$202,050

1999

$650,000

$211,300

2000

$675,000

$220,550

Chapter 8: Reference Material

2001

$675,000

$220,550

2002

$1,000,000

$345,800

2003

$1,000,000

$345,800

2004

$1,500,000

$555,800

2005

$1,500,000

$555,800

2006

$2,000,000

$780,800

2007

$2,000,000

$780,800

2008

$2,000,000

$780,800

2009

$3,500,000

$1,455,800

State Death Tax Calculations
Every state imposes a death tax at least equal to the state death tax credit allowed in
determining the federal estate tax, and 13 states (in 2000) impose an independent
inheritance, succession, or estate tax on transfers to spouses or heirs/beneficiaries that
may exceed the state death tax credit.
If the independent state death tax is more than the credit, the state imposes the tax. If the
independent state tax is less than the credit, the state will still impose what is often called
a “pickup” or “slack” tax equal to the difference, so the state will still collect the full state
death tax credit.
For simplicity, the program assumes the following:

•

Each case all of the decedent's assets are subject to the death tax of the
domiciliary estate (that is, there is no real property or tangible personal property
outside of the domicile that is subject to tax in a different state).

•

Any nonmarital trust is funded first with assets subject to state death taxes and
that any marital trust will qualify for any marital deduction or exemption for state
death tax purposes, even though the election may be separate from the federal
marital deduction election.

•

Trusts funded with assets that are not taxable at the first death are not taxable at
the second death because of appropriate elections, partial elections, division of
trusts into separate trusts, or other appropriate estate planning techniques. For
example, let’s say 25% of a marital trust is funded with assets subject to the state
death tax, and 75% is funded with life insurance or other assets that are not
subject to the state death tax. In such a case, the program assumes that 75% of the
value of the trust is still exempt from tax at the death of the surviving spouse, and
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the 75% is not included in the taxable estate or taxable transfers of the spouse for
the purpose of that death tax.
State Death Tax Credit
The maximum state death tax credit is calculated from the “adjusted taxable estate,”
which is the taxable estate less $60,000. This means that adjusted taxable gifts increase
the tentative tax base and federal estate tax but do not increase the state death tax credit.
The tax rates before 2002 are as follows:

Adjusted Taxable Estate

Credit

$0 to $90,000

0.8% of the amount over $40,000

$90,000 to $140,000

$400 plus 1.6%% over $90,000

$140,000 to $240,000

$1,200 plus 2.4% over $140,000

$240,000 to $440,000

$3,600 plus 3.2% over $240,000

$440,000 to $640,000

$10,000 plus 4% over $440,000

$640,000 to $840,000

$18,000 plus 4.8% over $640,000

$840,000 to $1,040,000

$27,600 plus 5.6% over $840,000

$1,040,000 to $1,540,000

$38,300 plus 6.4% over $1,040,000

$1,540,000 to $2,040,000

$70,800 plus 7.2% over $1,540,000

$2,040,000 to $2,540,000

$106,800 plus 8% over $2,040,000

$2,540,000 to $3,040,000

$146,800 plus 8.8% over $2,540,000

$3,040,000 to $3,540,000

$190,800 plus 9.6% over $3,040,000

$3,540,000 to $4,040,000

$238,800 plus 10.4% over $3,540,000

$4,040,000 to $5,040,000

$290,800 plus 11.2% over $4,040,000

$5,040,000 to $6,040,000

$402,800 plus 12.0% over $5,040,000

$6,040,000 to $7,040,000

$522,800 plus 12.8% over $6,040,000

$7,040,000 to $8,040,000

$650,800 plus 13.6% over $7,040,000

$8,040,000 to $9,040,000

$786,800 plus 14.4% over $8,040,000

$9,040,000 to $10,040,000

$930,800 plus 15.2% over $9,040,000
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Over $10,040,000

$1,082,800 plus 16% over $10,040,000

Under the Economic Growth and Tax Relief Reconciliation Act of 2001, the state death
tax credit will be reduced by 25% in 2002, by 50% in 2003, by 75% in 2004, and
eliminated in 2005, when estates will be allowed a deduction (not a credit) for state death
taxes paid.
Connecticut Succession Tax
Connecticut is phasing out its succession tax beginning in 1997 and ending with a
complete repeal in 2005. The tax table is the same, but there is an increasing exemption
each year: $250,000 in 1997, $500,000 in 1998, $800,000 in 1999, and $2,000,000 in
2000After 2000, there is no tax on property passing to a spouse, child or grandchild,
although the taxes on other classes of beneficiaries (not calculated by Estate Planning
QuickView) continues until 2005.
Following is a summary of how the Connecticut Succession Tax affects the elements of
an estate plan.

Life Insurance
Retirement Plans

Marital
Distributions
Marital Trust
Nonmarital Trust

Not taxable.
Benefits attributable to employer contributions are exempt. The
program allows you to enter a factor that will determine the
percentage of benefits taxable.
Not taxable.
Not taxable at the first death. Subject to tax at the second death.
Spouse’s life estate is not taxable. Present value of remainder to
children is taxable. The program allows you to enter a factor that will
determine the percentage of the trust that is taxable.

There is a $5,000 exemption on jointly owned bank accounts and U.S. Savings Bonds,
which is ignored in these calculations.

Taxable amount upon the death of the First-to-Die equals
The net assets of the first-to-die.
+

The taxable portion of retirement benefits.

-

The federal deduction (reduced by nontaxable life insurance and retirement benefits.

-

The nontaxable portion of the Nonmarital Trust (reduced by nontaxable life insurance
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and retirement benefits).

The program applies the exemption described above by calculating the tax and then by
subtracting the tax on the exemption amount.

Taxable amount upon the death of the Second-to-Die equals
The net assets of the survivor (including jointly owned property and marital
distributions from the estate of the first-to-die).
+

The taxable portion of the retirement benefits.

+

The value of the Marital Trust (if any), not including any life insurance and retirement
benefits that were not taxed upon the death of the first-to-die.

The program applies the exemption described above by calculating the tax and then by
subtracting the tax on the exemption amount.
Tax Rates

The program bases tax rates on the following table.

Amount

Tax

$0 to $2,000,000

$0

Over $2,000,000

11.44% of the amount over $1,000,000
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Delaware Inheritance Tax
Delaware has repealed its inheritance tax for deaths after 1998. Following is a summary
of how the Delaware Inheritance Tax affects the elements of an estate plan before 1999.

Life Insurance
Retirement Plans
Marital
Distributions

Benefits attributable to employer contributions are exempt. The
program allows you to enter a factor that will determine the
percentage of benefits taxable.
Not taxable.

Marital Trust

Not taxable upon the first-to-die. Subject to tax upon the death of the
second-to-die.

Nonmarital Trust

First-to-Die

Not taxable.

Spouse’s life estate is taxable at tax rates applicable to the secondto-die. The Present value of the remainder to children is taxable at
rates to children. The program allows you to enter a factor that will
determine the percentage of the trust that is taxable.

Upon the death of the first-to-die, the taxable amount for the surviving
spouse is the “nontaxable” portion of the Nonmarital Trust.

Taxable amount for each child equals
The net assets of the first-to-die.
+

The taxable portion of retirement benefits.

-

The federal deduction (reduced by nontaxable life insurance and retirement benefits).

-

The nontaxable portion of the Nonmarital Trust (reduced by nontaxable life insurance
and retirement benefits).

/

The number of children.
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The total tax on the children’s interests is the tax on each child’s share multiplied by the
number of children. The total inheritance tax is the total tax on the spouse's interests plus
the tax on the children’s interests.

Taxable amount upon the death of the Second-to-Die equals
The net assets of the second-to-die (including jointly owned property
and marital distributions from the estate of the first-to-die).
+

The taxable portion of the retirement benefits.

+

The value of the Marital Trust (if any), not including any life insurance
and retirement benefits that were not taxed upon the death of the
first-to-die.

/

The number of children.

The total tax on the children’s interests is the tax on each child’s share multiplied by the
number of children.

Tax Rates for the second-to-die
Amount

Tax

$0 to $70,000

$0

$70,000 to $100,000

$0 plus 2% over $70,000

$100,000 to $200,000

$600 plus 3% over $100,000

Over $200,000

$3,600 plus 4% over $200,000

Tax rates for children
Amount

Tax

$0 to $25,000

$0

$25,000 to $50,000

$0 plus 2% over $25,000

$50,000 to $75,000

$500 plus 3% over $50,000

$75,000 to $100,000

$1,250 plus 4% over $75,000

$100,000 to $200,000

$2,250 plus 5% over $100,000

Over $200,000

$7,250 plus 6% over $200,000
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Indiana Inheritance Tax
Following is a summary of how the Indiana Inheritance Tax affects the elements of an
estate plan.

Life Insurance

Not taxable.

Retirement Plans

Taxable.

Marital Distributions

Not Taxable.

Marital Trust

Nonmarital Trust

Not taxable upon the death of the first-to-die.
Taxable upon the death of the second-to-die.
Spouse’s life estate is not taxable. The present
value of the remainder to children is taxable. The
program allows you to enter a factor that will
determine the percentage of the trust that is taxable.

For deaths after 6/30/98, there is a $100,000 exemption for each child (or lineal
descendant).

Taxable amount for each child upon the death of the
First-to-Die
The net assets of the first-to-die.
+

The retirement benefits of the first-to-die.

-

The federal marital education (reduced by nontaxable life insurance).

-

The nontaxable portion of the Nonmarital Trust (reduced by
nontaxable life insurance and retirement benefits).

/

The number of children.

-

$100,000 exemption for each child.
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The total tax is the tax on each child’s share multiplied by the number of children.

Taxable amount upon the death of the Second-to-Die equals
The net assets of the second-to-die (including jointly owned property
and marital distributions from the estate of the first-to-die).
+

The retirement benefits of the second-to-die.

+

The value of the Marital Trust (if any), not including any life insurance
and retirement benefits that were not taxed upon the death of the
first-to-die.

/

The number of children.

-

$100,000 exemption for each child.

The total tax is the tax on each child’s share multiplied by the number of children.
Tax Rates

Amount

Tax

$0 to $25,000

1%

$25,000 to $50,000

$250 plus 2% over $25,000

$50,000 to $200,000

$750 plus 3% over $50,000

$200,000 to $300,000

$5,250 plus 4% over $200,000

$300,000 to $500,000

$9,250 plus 5% over $300,000

$500,000 to $700,000

$19,250 plus 6% over $500,000

$700,000 to $1,000,000

$31,250 plus 7% over $700,000

$1,000,000 to $1,500,000

$52,250 plus 8% over $1,000,000

Over $1,500,000

$92,250 plus 10% over $1,500,000
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Louisiana Inheritance Tax
By Act 818 of 1997, Louisiana repealed its inheritance tax, effective July 1, 2004.
Between July 1, 1998, and July 1, 2004, the tax will be reduced in stages:
•

Rates between July 1, 1998 and July 1, 2001 will be reduced by 18%.

•

Rates between July 1, 2001 and July 1, 2002 will be reduced by 40%.

•

Rates between July 1, 2002 and July 1, 2003 will be reduced by 60%.

•

Rates between July 1, 2003 and July 1, 2004 will be reduced by 80%.

For simplicity, the program assumes that the rates in effect in the last half of each year
are the rates in effect through the entire year.
Following is a summary of how the Louisiana Inheritance Tax affects the elements of an
estate plan.

Life Insurance
Retirement Plans
Marital
Distributions
Marital Trust
Nonmarital Trust

Not taxable.
Not taxable.
Not taxable.
Not taxable upon the death of the first-to-die.
Taxable upon the death of the second-to-die.
Taxable. No exemption for spouse’s life estate.

Taxable amount for each child upon the death of the
First-to-Die
The net assets of the first-to-die.
-

The federal marital education (reduced by nontaxable life insurance
and retirement plans).

/

The number of children.

-

A $25,000 exemption for each child.
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The total tax is the tax on each child’s share multiplied by the number of children.

Taxable amount upon the death of the Second-to-Die equals
The net assets of the second-to-die (including jointly owned property
and marital distributions from the estate of the first-to-die).
+

The retirement benefits of the second-to-die.

+

The value of the Marital Trust (if any), not including any life insurance
and retirement benefits that were not taxed upon the death of the
first-to-die.

/

The number of children.

-

A $25,000 exemption for each child.

The total tax is the tax on each child’s share multiplied by the number of children.

Tax Rates
Year of Death

1997

1998, 1999, 2000

2001

2002
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Amount

Tax

$0 to $20,000

2%

Over $20,000

$400 plus 3% over
$20,000

$0 to $20,000

1.64%

Over $20,000

$328 plus 2.46% over
$20,000

$0 to $20,000

1.2%

Over $20,000

$240 plus 1.8% over
$20,000

$0 to $20,000

.08%

Over $20,000

$160 plus 1.2% over
$20,000

$0 to $20,000

.04%
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2003

$80 plus .06% over
$20,000

Over $20,000

No Tax
2004 or later

Maryland Inheritance Tax
Following is a summary of how the Maryland Inheritance Tax affects the elements of an
estate plan.

Life Insurance

Not taxable.

Retirement Plans

Not taxable.

Marital Distributions
Marital Trust

Taxable.
Taxable in full upon the death of the first-to-die.

Nonmarital Trust

Taxable. No exemption for spouse’s life estate.

There is no tax on real property passing to the surviving spouse, or the first $100,000 of
any other property passing to the surviving spouse. For simplicity, it is assumed that all
real estate is owned jointly, so that the separate estate of the first spouse to die is entirely
taxable, less only the $100,000 exemption for the interests of the surviving spouse.
Effective 7/1/2001, Maryland exempts from inheritance tax all property passing to
children or lineal descendents. Because QuickView assumes that the ultimate
beneficiaries are children or lineal descendents, this means there is no inheritance tax as
far as QuickView is concerned.

First-to-Die

Second-to-Die

Tax Rate

Upon the first-to-die, the taxable amount is equal to the
net assets of the first-to-die less $100,000 but not more
than the federal marital deduction (reduced by life
insurance and retirement benefits) passing outright (not
in trust).
Upon the death of the second-to-die, the taxable amount
is equal to the net assets of the second-to-die (including
jointly owned property and marital distributions from the
estate of the first-to-die).

1%.
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Mississippi Inheritance Tax
Mississippi has repealed its inheritance tax effective for the year 2000.
Following is a summary of how the Mississippi Inheritance Tax affects the elements of
an estate plan.

Life Insurance

Taxable.

Retirement Plans

Taxable.

Marital
Distributions

Not taxable.

Marital Trust

Not taxable upon the death of the first-to-die.
Taxable upon the death of the second-to-die.

Nonmarital Trust

Taxable. No exemption for spouse’s life estate.

First-to-Die

Upon the death of the first-to-die, the taxable amount is
the same as the federal taxable estate less the specific
exemption described below under “Tax Rates.”

Second-to-Die

Upon the death of the second-to-die, the taxable amount
is the same as the federal taxable estate less the specific
exemption described below under “Tax Rates.”

Tax Rates

The program calculates the taxable estate by subtracting all other deductions from the
gross estate and then subtracting the following exemption:

42

Year

Exemption

1997

$600,000

1998

$625,000

1999

$650,000

2000

$675,000
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2001

$675,000

2002

$700,000

2003

$700,000

2004

$850,000

2005

$950,000

After 2005

$1,000,000

The tax is calculated from the taxable estate as follows:

Amount

Tax

$0 to $60,000

1%

$60,000 to $100,000

$600 plus 1.6%% over $60,000

$100,000 to $200,000

$1,240 plus 2.4% over $100,000

$200,000 to $400,000

$3,640 plus 3.2% over $200,000

$400,000 to $600,000

$10,040 plus 4% over $400,000

$600,000 to $800,000

$18,040 plus 4,8% over $600,000

$800,000 to $1,000,000

$27,640 plus 5.6% over $800,000

$1,000,000 to $1,500,000

$38,380 plus 6.4% over $1,000,000

$1,500,000 to $2,000,000

$70,840 plus 7.2% over $1,500,000

$2,000,000 to $2,500,000

$106,840 plus 8% over $2,000,000

$2,500,000 to $3,000,000

$146,840 plus 8.8% over $2,500,000

$3,000,000 to $3,500,000

$190,840 plus 9.6% over $3,000,000

$3,500,000 to $4,000,000

$238,840 plus 10.4% over $3,500,000

$4,000,000 to $5,000,000

$290,840 plus 11.2% over $4,000,000

$5,000,000 to $6,000,000

$402,840 plus 12.0% over $5,000,000

$6,000,000 to $7,000,000

$522,840 plus 12.8% over $6,000,000

$7,000,000 to $8,000,000

$650,840 plus 13.6% over $7,000,000

$8,000,000 to $9,000,000

$786,840 plus 14.4% over $8,000,000
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$9,000,000 to $10,000,000

$930,840 plus 15.2% over $9,000,000

Over $10,000,000

$1,082,840 plus 16% over $10,000,000

Nebraska Inheritance Tax
Following is a summary of how the Nebraska Inheritance Tax affects the elements of an
estate plan.

Life Insurance

Not taxable.

Retirement Plans

Taxable.

Marital Distributions

Not Taxable.

Marital Trust

Nonmarital Trust

Not taxable at either death (for trusts with
general powers of appointment).
Spouse’s life estate is not taxable. The
present value of the remainder to children
is taxable. The program allows you to
enter a factor that will determine the
percentage of the trust that is taxable.

There is a deduction for federal estate tax paid.
There is a $10,000 exemption for each beneficiary.
There is also a homestead allowance of $7,500 (applicable only to a surviving spouse or
minor children), a family exemption of $5,000, and a family maintenance allowance of
$9,000 (applicable only to a surviving spouse or minor children), or a total of $21,500 in
exemptions at the first death. For simplicity, it is assumed that all children are adults at
the second death, and only the $5,000 family exemption applies.

Taxable amount upon the death of the First-to-Die equals
The net assets of the first-to-die.
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+

The retirement benefits of the first-to-die.

-

The federal marital deduction (reduced by life insurance).

-

The nontaxable portion of the Nonmarital Trust (reduced by life
insurance and any federal estate tax payable).

Chapter 8: Reference Material

-

The $21,500 family exemptions described above.

-

A $10,000 exemption for each child.

Taxable amount upon the death of the Second-to-Die equals
The net assets of the second-to-die (including jointly owned property
and marital distributions from the estate of the first-to-die, but not
including the marital Trust).
+

The retirement benefits of the second-to-die.

-

The $5,000 family exemption described above.

-

A $10,000 exemption for each child.

-

The federal estate tax payable (if any).

Tax Rate

1% for children and grandchildren
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Ohio Estate Tax
Following is a summary of how the Ohio Estate Tax affects the elements of an estate
plan. Ohio has a $500 credit against tax, so any Ohio tax should be reduced by $500 (but
not below zero). For deaths in 2001, the credit increases to $6,600, and then increases
again to $13,900 for deaths after 2001.

Life Insurance

Retirement Plans
Marital
Distributions
Marital Trust
Nonmarital Trust

Not taxable
Benefits attributable to employer contributions are
exempt. The program will allow you to enter a
factor that will determine the percentage of
taxable benefits.
Not Taxable.
Not taxable upon the death of the first-to-die.
Subject to tax upon the death of the second-todie.
Taxable. No exemption for spouse's life estate.

Taxable amount upon the death of the First-to-Die equals
The net assets of the first-to-die.
+

The taxable portion of retirement benefits.

-

The federal martial deduction (reduced by the nontaxable life
insurance and retirement benefits).

Taxable amount upon the death of the Second-to-Die equals
The net assets of the second-to-die (including jointly owned property
and marital distributions from the estate of the first-to-die).
+
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the taxable portion of retirement benefits.
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+

the value of the Marital Trust (if any), not including any life insurance
and retirement benefits that were not taxed upon the death of the
first-to-die.

Tax Rates

Amount

Tax

$0 to $40,000

2%

$40,000 to $100,000

$800 plus 3% over $40,000

$100,000 to $565,000

$2,600 plus 4% over $100,000

$200,000 to $815,000

$6,600 plus 5% over $200,000

$300,000 to $815,000

$11,600 plus 6% over $300,000

Over $500,000

$23,600 plus 7% over $500,000
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Oklahoma Estate Tax
Following is a summary of how the Oklahoma Inheritance Tax affects the elements of an
estate plan.

Life Insurance

Retirement Plans
Marital
Distributions
Marital Trust

Nonmarital Trust

Not taxable.
Benefits attributable to employer contributions are
exempt. The program will allow you to enter a
factor that will determine the percentage of
taxable benefits.
Not Taxable.
Spouse’s life estate is not taxable. Present value
of remainder to children is taxable.
Spouse’s life estate is not taxable. Present value
of remainder to children is taxable. The program
allows you to enter a factor that will determine the
percentage of the trust that is taxable.

Exemptions
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Year of Death

Exemption

Before 1999

$175,000

1999

$275,000

2000

$475,000

2001

$675,000

2002 and 2003

$700,000

2004

$850,000

2005

$950,000

After 2005

$1,000,000
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Taxable amount upon the death of the First-to-Die equals
The net assets of the first-to-die.
+

The taxable portion of retirement benefits.

-

The federal marital deduction (reduced by nontaxable life insurance
and retirement benefits).

-

The nontaxable portion of the Marital Trust (reduced by nontaxable
life insurance and retirement benefits).

-

The nontaxable portion of the Nonmarital Trust (reduced by
nontaxable life insurance and retirement benefits).

-

The exemption described above.

Taxable amount upon the death of the Second-to-Die equals
The net assets of the second-to-die (including jointly owned property
and marital distributions from the estate of the first-to-die).
+

The nontaxable portion of retirement benefits.

-

The exemption described above.

Tax Rates

Amount

Tax

0 to $10,000

1%

$10,000 to $25,000

$100 plus 2% over $10,000

$25,000 to $50,000

$400 plus 3% over $25,000

$50,000 to $100,000

$1,150 plus 4% over $50,000

$100,000 to $200,000

$3,150 plus 5% over $100,000

$200,000 to $500,000

$8.150 plus 6% over $200,000

$500,000 to $1,000,000

$26,150 plus 7% over $500,000

$1,000,000 to $1,500,000

$61,150 plus 8% over $1,000,000
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$1,500,000 to $2,000,000

$101,150 plus 9% over $1,500,000

$2,000,000 to $2,500,000

$146,150 plus 10% over $2,000,000

$2,500,000 to $3,000,000

$196,150 plus 11% over $2,500,000

Over $3,000,000

$251,150 plus 12% over $3,000,000

50

Chapter 8: Reference Material

Pennsylvania Inheritance Tax
Following is a summary of how the Pennsylvania Inheritance Tax affects the elements of
an estate plan.

Life Insurance

Retirement Plans

Marital
Distributions

Marital Trust

Nonmarital Trust

Not taxable.
Not taxable. Retirement plans are subject to tax if the decedent had
the “right to possess” the benefits without penalty. Benefits are
usually taxable if the client is over 59½. In such a case, enter the
value of the retirement plans as part of the client's assets and not as
retirement benefits.
Not taxable.
Not taxable upon the death of the first-to-die. Are subject to tax upon
the death of the second-to-die. Nontaxable life insurance added to a
marital trust will result in tax on those proceeds upon the death of the
second-to-die. However, it is assumed that separate trusts will be
created, or that this tax trap will be otherwise avoided.
Spouse’s life estate is not taxable. Present value of remainder to
children is taxable. The program allows you to enter a factor that will
determine the percentage of the trust that is taxable.

Taxable amount upon the death of the First-to-Die equals
The net assets of the first-to-die.
-

The federal marital deduction (reduced by nontaxable life insurance and retirement
benefits).

-

The nontaxable portion of the Nonmarital Trust (reduced by the life insurance and
retirement benefits).

Taxable amount upon the death of the Second-to-Die equals
The net assets of the second-to-die (including jointly owned property and marital
distributions from the estate of the first-to-die).
+

The value of the Marital Trust (if any), not including any life insurance and retirement
benefits that were not taxed upon the death of the first-to-die.
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Tax Rate

The tax is 4.5% of the net amount passing to or for the children.

South Dakota Inheritance Tax
South Dakota has repealed its inheritance tax, effective 7/1/2001.
Following is a summary of how the South Dakota Inheritance Tax affects the elements of
an estate plan.

Life Insurance

Not taxable.

Retirement Plans

Not taxable.

Marital
Distributions

Not taxable.

Marital Trust

Not taxable upon the death of the first-to-die. Subject to tax upon
the death of the second-to-die.

Nonmarital Trust

Spouse’s life estate is not taxable. Present value of remainder to
children is taxable. The program allows you to enter a factor that
will determine the percentage of the trust that is taxable.

South Dakota will be increasing the exemption for each child from $30,000 to $100,000
in $10,000 increments as follows (for simplicity, the program assumes that the rates in
effect in the last half of each year are the rates in effect through the entire year):
Effective July 1, 2000

exemption is $40,000

Effective July 1, 2001

exemption is $50,000

Effective July 1, 2002

exemption is $60,000

Effective July 1, 2003

exemption is $70,000

Effective July 1, 2004

exemption is $80,000

Effective July 1, 2005

exemption is $90,000

Effective July 1, 2006

exemption is $100,000

Taxable amount upon the death of the First-to-Die equals
The net assets of the first-to-die.
-
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The federal marital deduction (reduced by nontaxable life insurance
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and retirement benefits).
-

The nontaxable portion of the Nonmarital Trust (reduced by the life
insurance and retirement benefits).

/

The number of children.

The program calculates total tax by multiplying the tax on each child’s share by the
number of children.

Taxable amount upon the death of the Second-to-Die equals
The net assets of the second-to-die (including jointly owned property
and marital distributions from the estate of the first-to-die).

+

The value of the Marital Trust (if any), not including any life insurance
and retirement benefits that were not taxed upon the death of the
first-to-die.

/

The number of children.

-

The $30,000 exemption described above.

The program calculates total tax by multiplying the tax on each child’s share by the
number of children.
Tax Rates

For deaths in 2000, the tax on each child’s share is
calculated as follows:
$0 to $40,000

tax is $0

$40,000 to $50,000

tax is 3.75% of the amount over $40,000

$50,000 to $100,000

tax is $375 plus 6% of the amount over

Over $100,000

tax is $3,375 plus 7.5% of the amount over
$100,000

For deaths in 2001, the tax on each child’s share is
calculated as follows:
$0 to $50,000

tax is $0

$50,000 to $100,000

tax is 6% of the amount over $50,000
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Over $100,000

tax is $3,000 plus 7.5% of the amount over
$100,000

For deaths in 2002, the tax on each child’s share is
calculated as follows:
$0 to $60,000

tax is $0

$60,000 to $100,000

tax is 6% of the amount over $60,000

Over $100,000

tax is $2,400 plus 7.5% of the amount over
$100,000

For deaths in 2003, the tax on each child’s share is
calculated as follows:
$0 to $70,000

tax is $0

$70,000 to $100,000

tax is 6% of the amount over $70,000

Over $100,000

tax is $1,800 plus 7.5% of the amount over
$100,000

For deaths in 2004, the tax on each child’s share is
calculated as follows:
$0 to $80,000

tax is $0

$80,000 to $100,000

tax is 6% of the amount over $80,000

Over $100,000

tax is $1,200 plus 7.5% of the amount over
$100,000

For deaths in 2005, the tax on each child’s share is
calculated as follows:
$0 to $90,000

tax is $0

$90,000 to $100,000

tax is 6% of the amount over $90,000

Over $100,000

tax is $600 plus 7.5% of the amount over
$100,000
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For deaths in 2005, the tax on each child’s share is
calculated as follows:
$0 to $90,000

tax is $0

$90,000 to $100,000

tax is 6% of the amount over $90,000

Over $100,000

tax is $600 plus 7.5% of the amount over
$100,000

For deaths in 2006, the tax on each child’s share is
calculated as follows:
$0 to $100,000

tax is $0

Over $100,000

tax is 7.5% of the amount over $100,000
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Tennessee Inheritance Tax
Following is a summary of how the Tennessee Inheritance Tax affects the elements of an
estate plan.

Life Insurance

Not taxable.

Retirement Plans

Not taxable.

Marital Distributions

Not taxable.

Marital Trust

Not taxable upon the death of the first-to-die.
Subject to tax upon the death of the second-todie.

Nonmarital Trust

Taxable. There is not an exemption for the
spouse’s life estate.

First-to-Die

Upon the death of the first-to-die, the taxable amount is
equal to the federal taxable estate of the first-to-die less
the single exemption described below.

Second-to-Die

Upon the death of the second-to-die, the taxable amount
is equal to the federal taxable estate of the second-todie less the single exemption described below.

Tax Rates
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The net taxable estate is determined by subtracting a single exemption, as follows:

Year

Exemption

1997

$600,000

1998

$625,000

1999

$650,000

2000

$675,000

2001

$675,000

2002

$700,000

2003

$700,000

2004

$850,000

2005

$950,000

2005

$1,000,000

The tax is computed from the net taxable estate as follows:

Amount

Tax

$0 to $40,000

5.5%

$40,000 to $240,000

$2,200 plus 6.5% over $40,000

$240,000 to $440,000

$15,200 plus 7.5% over $240,000

Over $440,000

$30,200 plus 9.5% over $440,000
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Getting Help

If you need help, it’s easy to find. Click the question mark on the toolbar and a Help topic
appears. Also, use the Help menu and the Help System. If you still need help, Brentmark
provides technical support.
Help Menu
Use the Help menu on the Menu bar to access the Help system, learn how to use Help, or
view information about this product and other Brentmark products.
Help System
The program provides a complete Help system, so you can get help whenever you need
it. Just click the question mark that appears on the toolbar. Use the Help system’s Table
of Contents to view Help topics by category or search the Help index for specific terms.
Technical Support
Technical Support is available by telephone, fax, e-mail, or postal mail. If you have
questions concerning program calculations, please have a list of your exact data entry
values available when contacting us.
Telephone

Assistance by telephone is available Monday through Friday between 9:00 AM and
6:00PM Eastern Standard Time at (407) 306-6160.
Fax

For assistance by fax, send your fax to (407) 306-6107.
E-mail

For assistance via e-mail, send your questions and comments to support@brentmark.com.
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Postal Mail

For assistance by postal mail, send your questions to the following address:
Brentmark Software, Inc.
3505 Lake Lynda Drive, Suite 212
Orlando, FL 32817-8327

Please include the following information in your correspondence:
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•

The name to which the program is registered.

•

A contact phone number.

•

The program name and version number.

•

Your system configuration.

•

A sample printout or description of the problem.

•

A list of any error messages that have appeared.

License Agreement
This software is protected by both United States copyright law and international treaty provisions. You
must treat this software just like a book, except that you may copy it onto a computer to be used and you
may make archival copies of the software for the sole purpose of backing up our software and protecting
your investment from loss. You must also agree not to reverse engineer the software.
By saying “just like a book, Brentmark means, for example, that this software may be used by any number
of people, and may be freely moved from one computer location to another, so long as there is no
possibility of it being used at one location or on one computer while it is being used at another. Just like a
book cannot be read by two different people in two different places at the same time, neither can the
software be used by two different people in two different places at the same time (unless, of course,
Brentmark's copyright is being violated).
Limited Warranty
Brentmark Software, Inc. warrants the physical diskette(s) and physical documentation enclosed herein to
be free of defects in materials and workmanship for a period of sixty days from the purchase date. If
Brentmark receives notification within the warranty period of defects in materials or workmanship, and
such notification is determined by Brentmark to be correct, Brentmark will replace the defective diskette(s)
or documentation.
The entire and exclusive liability and remedy for breach of this Limited Warranty shall be limited to
replacement of defective diskette(s) or documentation and shall not include or extend to any claim for or
right to recover any other damages, including but not limited to, loss of profit, data or use of the software,
or special, incidental or consequential damages or other similar claims, even if Brentmark has been
specifically advised of the possibility of such damages. In no event will Brentmark's liability for any
damages to you or any other person ever exceed the lower of suggested list price or actual price paid for the
license to use the software, regardless of any form of the claim.
BRENTMARK SOFTWARE, INC. SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Specifically, Brentmark makes
no representation or warranty that the software is fit for any particular purpose and any implied warranty of
merchantability is limited to the sixty day duration of the Limited Warranty covering the physical
diskette(s) and physical documentation only (and not the software) and is otherwise expressly and
specifically disclaimed.
The limited warranty gives you specific legal rights; you may have others which may vary from state to
state. Some states do not allow the exclusion of incidental or consequential damages, or the limitation on
how long an implied warranty lasts, so some of the above may not apply to you.
Governing Law and General Provisions
The License Statement and Limited Warranty shall be construed, interpreted and governed by the laws of
the State of Florida and any action hereunder shall be brought only in Florida. If any provision is found
void, invalid or unenforceable it will not affect the validity of the balance of this License and Limited
Warranty which shall remain valid and enforceable according to its terms. If any remedy hereunder is
determined to have failed of its essential purpose, all limitations of liability and exclusion of damages set
forth herein shall remain in full force and effect. This License and Limited Warranty may only be modified
in writing signed by you and a specifically authorized representative of Brentmark. All rights not
specifically granted in this statement are reserved by Brentmark.

61

Estate Planning QuickView

62

Index
A

Gross Assets ........................................ 14
Growth................................................. 11

Adjustable Taxable Gifts..................... 11
Assumptions .......................................... 3

H

C

Heading ............................................... 23
Heirs .................................................... 13

Client Data Section............................ 4, 9
Community Property............... 10, 14, 27
Connecticut Succession Tax................ 32
Cover Page .......................................... 24
Current Year........................................ 13
D
Data Entry ............................................. 9
Date and Time ..................................... 24
Death Taxes......................................... 27
Debts or Fixed Expenses ..................... 14
Delaware Inheritance Tax ................... 34
Domicile ........................................ 11, 15

I
Indiana Inheritance Tax....................... 36
Installing................................................ 1
Insurance ................................. 10, 11, 12
on 2nd-To-Die ................................. 12
on Husband ...................................... 12
on Wife ............................................ 12
L
License Agreement.............................. 59
Life Insurance.......................... 10, 11, 12
Louisiana Inheritance Tax................... 38

E

M

Estate Growth...................................... 11
Estate Tax...................................... 27, 28
Exiting the Program .............................. 8
Expenses.............................................. 14

Marital Deduction ............................... 28
Marital Trust........................................ 13
Maryland Inheritance Tax ................... 40
Menu Bar............................................... 4
Mississippi Inheritance Tax ................ 41

F
Federal Estate Tax......................... 27, 28
Files ....................................................... 7
Creating ............................................. 7
Opening ............................................. 7
Saving ............................................ 7, 8
First-to-Die .......................................... 25
Flowcharts ..................................... 20, 25
Fonts .................................................... 23
Frequently Used Commands ................. 5
Frequently Used Procedures ................. 7
Function Keys ....................................... 5
G

N
Name ................................................... 12
Names.................................................... 9
Nebraska Inheritance Tax.................... 43
Net Assets............................................ 10
Nonmarital Trust ........................... 13, 15
Nontaxable Assets ............................... 12
Nontaxable Trust ................................. 13
Number of Children ............................ 15
O
Ohio Estate Tax................................... 45
Oklahoma Inheritance Tax .................. 47

Graphs ................................................. 21

63

Estate Planning QuickView

P
Page Margins....................................... 23
Page Numbers ..................................... 24
Pennsylvania Inheritance Tax ............. 50
Plans 1 and 9 ....................................... 17
Plans 2 and 10 ..................................... 17
Plans 3 and 11 ..................................... 17
Plans 4 and 12 ..................................... 18
Plans 5 and 13 ..................................... 18
Plans 6 and 14 ..................................... 19
Plans 7 and 15 ..................................... 19
Plans 8 and 16 ..................................... 20
Preferences ................................ 9, 12, 13
Print Preview ....................................... 26
Printer Setup........................................ 26
Printing ................................................ 25
Printing Options .................................. 24
Probate Percentage .............................. 14
R
Report Options .............................. 23, 24
Reports .......................................... 25, 26
Retirement Benefits............................. 15
Retirement Plans ................................. 11
S
South Dakota Inheritance Tax............. 51
Spreadsheet File .................................. 26

64

State..................................................... 11
State Death Tax ....................... 15, 27, 30
State Inputs.......................................... 15
Status ..................................................... 9
Summary Reports................................ 21
T
Taxable Gifts ....................................... 11
Taxes ................................................... 27
Technical Support ............................... 57
Tennessee Inheritance Tax .................. 55
Text File .............................................. 26
Three-Year Rule............................ 10, 13
Title ..................................................... 12
Title Bar................................................. 3
Toolbar .................................................. 4
U
Unified Credit................................ 28, 29
Uninstalling ........................................... 1
Y
Year ..................................................... 13
Year of First Death.............................. 11
Year of Second Death ......................... 11
Z
Zoom ................................................... 26

